
A Second Look at DLG’s 

What is a DLG 

A dlg is a digital line graph and contains much of the line information shown on 
1:24,000; 1:100,000; or 1:250,000 scale “hard copy” topographic map.  For many if 
not most geologists, dlg’s will be the most useful dataset.  These data have been 
produced for some time by the USGS and many software packages (including 
SURFER) have the capability of reading them). 
Although originally produced and distributed by the USGS, dlg’s are available from a 
number of federal, state, and commercial sources.  We have already looked at one, 
the state of Ohio (exclusively 1:24,000 scale).  A number of you have found similar 
sites on websites for other states.  Ohio has 100% coverage of the state by 1:24,000 
dlg’s.  It is important to note, however, these dlg’s are in the older, more convenient 
“original” ASCII format (you can read them with any text editor) and is described in 
detail in this pdf.  Some, but by no means all, of the dlg’s are available in SDTS 
format from either EROS or from commercial sites such Geocommunity (for which 
you all now have accounts).  The original and the SDTS formats are quite different 
and must be handled differently. 

Downloading dlg data  

From Ohio 
We already downloaded data from Ohio’s website in our first class by copying them 
directly from the browser.  Let’s do it more efficiently this time by using an FTP client 
available free from UC, ws_ftp (which should be on all 3rd floor lab machines).  When 
you first fire it up, it should look something like this (click the “New” button if it 
doesn’t) 

ftp://ftp.geodata.gis.state.oh.us/geodata/dlg/24000/
http://homepages.uc.edu/~nashdb/courses/GIS in Geology/dlg users guide.PDF
http://edc.usgs.gov/geodata/
http://data.geocomm.com/
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Fill it in to look like this (obviously replacing [put your email address here] with your 
email address) and press the “Save” button. 

 
Pressing the “Ok” button should give you this screen: 
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In the left panel, click on the D drive symbol [-d-] and navigate to a convenient folder 
or make a new one by pressing the “MkDir” button.  In the right panel double click on 
“geodata” then “dlg” then “24000”.  Click once on “dlg_index.txt” in the lower panel 
on the right side and click the “View” button. 



Second Look at dlg’s page 4 

 
Here you find the complete dlg coverage for each state.  As demonstrated in class, 
this document shows the directory and file label of each quadrangle.  So, for 
instance, the Belfast quad is in the files labeled CW328 in the Hillsboro directory.  
Let’s take a look.  Double click on “data” in the upper right-hand panel, scroll down 
the “hillsboro” and double click it (may to a minute to list the files in that directory).  
Scroll down the CW328 
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Remember that there’ll be seven files corresponding to  
geodata identifier: BD - digital line graph (DLG) boundaries 

• BD – boundaries (city, park, etc.) 

• HY -hydrography 

• PL -public land survey (township, range, section) 

• RD -roads 

• RR -railroads 

• MT -miscellaneous transportation (pipelines, power lines, airports, etc.) 

• HP -hypsography (topographic contour) 

Select them all using shift-click and press the  button between the left and right 
panels to download the data to the selected directory. 

From the Federalis 
For the time being, at least, some dlg dataset may be downloaded from the EROS 
GEODATA site.  There are a number of ways this can be done with a browser but, 
again, it can be done much easier with an ftp client.  I say “for the time being” 
because this site also used to distribute dem datasets but then shifted this task to 

http://edc.usgs.gov/geodata/
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commercial vendors.  Because these same vendors also distribute dlg’s, it wouldn’t 
surprise me if eventually all distribution of these datasets was transferred to 
commercial vendors.  Currently it’s much easier to download these data from EROS. 
Start up ws_ftp (click “close” if it’s already open), click “Connect” then “New”.  Fill in 
the panel to look like this and click “Save” 

 
Using the same procedure discussed above, navigate to 
/pub/data/DLG/LARGE_SCALE by double clicking “DLG” then “LARGE_SCALE” in 
the upper right-hand panel.  Double click on “B” in the upper right-hand panel and 
prepare to wait while the directory is listed (could take a minute or more).  Listed 
here are all the available dlg’s for the US that begin with the letter B (there’re a lot).  
Scroll down to Belfast_OH and highlight it by clicking once.  Navigate to the directory 
to which you want to download the data using the left-hand panel and the procedure 
used previously.  Again, press the left-pointing arrow to download the data.  This 
time you’ll be warned that you’re downloading a directory.  Press the “Ok” button. 
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Making the dlg readable by ArcMap 

Okay, you’ve now downloaded the same dataset in two different formats: the original 
and SDTS dlg formats.  With some work using the ESRI ArcToolbox you could get 
these data into a format readable by ArcMap… or you could take the much easier 
route and use Global Mapper.  Let’s use two adjacent quadrangles.  Download the 
Sinking Springs quad too. 
Load the hypsography sheets for the two adjacent quads into Global Mapper. 
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Export the data as a polyline shapefile (there’re point data as well but we won’t use 
it).  Note that these two quads will be merged and exported as one theme… this 
obviates the need for merging them in ArcMap (an easy but time consuming 
process). 

Processing dlg with Arcmap 

Open the shapefile with ArcMap. 
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Notice that one of the exported polylines is the edge line around the sheets.  Let’s 
get rid of it.  If the “edit” toolbar is not visible, make it so using View>Toolbars.  On 
the editor toolbar, pull down to “start editing”.  Using the edit bar selector, you could 
click on every unwanted line segment and press delete (but you’d go nuts or blind 
long before you’d finished).  There’s a much easier way.  Right click on the theme 
label in the left-hand panel and select “Open Attribute Table”. 
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Pull down to “Select by Attributes” under “Options” 
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Click or type "ELEVATION" = 0 AND "DLGMAJ_0" = 0 AND "DLGMIN_0" = 0 AND 
"DLGMAJ_1" =0 AND "DLGMIN_1" =0 and press “Apply”.  Close the select attribute 
windows and the attribute table.  Notice that all the edge lines are now selected 
(show in light blue).   

 
If you are currently editing, you may hit “Delete” and all those selected lines will be 
deleted (if not, pull down Editor>Start Editting”).  Pull down on the editor to “stop 
editing” and save the cleaned up dataset. 
Now let’s use appropriate colors for the contour lines.  For these maps the contour 
interval is 20 feet.  Let’s make every fifth contour line heavier (i.e., make every even 
100 foot contour line different).  Again open the attributes table and, as we did last 
week, and add a new field labeled “BOLD” using the “Options” pull down. 
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Once this field has been added, left click on the heading and select “Calculate 
values…”.  Either type or click [ELEVATION] mod 100 = 0.  ‘mod” determines the 
“remainder” of a division.  In other words 5 mod 2 is 1 and 950 mod 100 is 50.  So, if 
a number mod 100 is 0, it must be evenly divisible by 100. 

 
Note that every elevation that’s an even multiple of 100 has a “BOLD” value of -1 
(true) and number not an even multiple as 0 (false). 
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Close the attributes table and open the theme properties to the Symbology tab. 

 
Double click on the line to the left of the -1 (line corresponding to 100-foot contour 
lines) and select the bold “index” contour line. 
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Use the same procedure to specify “Contour Topographic, Intermediate” for the 
intermediate contours 
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It’s starting to look like a real map (note that I changed the labels in the table of 
contents)! 
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Now let’s label the contour lines (only the 100-foot lines).  Open the theme’s 
properties and select the “Labels” tab.  Enter the values shown below. 
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Click the “SQL Query” button and type or click “"BOLD" = -1”. 
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Click “OK” then click the “Label Placement Options” button and enter the values 
shown below. 



Second Look at dlg’s page 19 

 
Click “OK” then click the “Label Styles…” button and enter an appropriate lettering 
style for the contour labels. 
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Click “OK” until you get back to the main menu and you should see something like 
this. 
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What’s that you say?  It doesn’t look so good?  Well, it was done automatically.  You 
can do it better manually.  Go back to theme properties and click the label tab but 
this time make sure “Label Features in this layer” box is unchecked.  Close the 

properties box and select the label tool ( ) from the labeling pull down menu.  
The dialog below will appear; fill it out as shown.   
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Clicking on the bold 100-foot contour line should produce an elevation label at the 

point clicked.  Use  to move and rotate the label respectively as necessary. 

Producing a shaded relief map Arcmap 

Shaded relief maps may be produced from an elevation matrix dataset (e.g., a DEM) 
using the Spatial Analyst and 3D Analyst extensions.  They may also be produced 
directly from a hypsometry dlg (although the process is not as simple or 
straightforward as producing them directly from a DEM).  The first thing to check is 
that both these extensions are enabled.  Pull down Tools>Extensions… and make 
sure the dialog box appears as below. 
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Pull down View>Toolbars and make sure that the Spatial Analyst and 3D Analyst 
toolbars are visible.  Create a triangular irregular network (TIN) by pulling down 3D 
Analyst>Create/Modify TIN>Create TIN From Features… and fill out the dialog box 
as shown below (note: depending on what you named the topography theme, a 
name other than “hp” may appear).  Needless to say (I hope) the location to which 
this dataset is to be written will differ on your machine. 
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Click “OK” and wait (and wait…depending on the map and the size of the area 
covered, this will take a long to very long time to complete… five to ten minutes). 
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The resulting shaded relief map is decent (particularly if not viewed too closely).  The 
tin may be converted to a raster which processes much faster.  Pull down 3D 
Analyst>Convert>Tin to Raster and fill out the dialog as follows (again, the name 
and location of your dataset will be different). 

 
When complete, the raster will look like this. 

 
Select 3D Analyst>Surface Analysis>Hillshade… and fill out the dialog as follows. 
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Shaded relief map should be produced quickly this time. 

 
Remove all themes from the project except hillshade and the contour lines (right 
click in the table of contents and select “Remove”).  .Click and drag the contour line 
theme in the table of contents to the top of “Layers” (i.e., immediately above the 
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hillshade layer.  Get the properties for the hillshade them (the same way you’ve 
done several times already) and click the “Display” tab. And turn up the transparency 
to 50% so it doesn’t interfere so much with the contour lines.  You should now have 
a presentable shaded relief map. 

 

 


